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Der eStick ist ein USB basiertes Entwicklungs-Board fiir Atmel AT90USB162 Mikrocontroller.
Einfache, anschauliche Anwendungen und Beispiele basierend auf dieser Hardware Plattform
verfolgen das Ziel jedem Interessierten an der Technik einen ndheren Einblick in die Elektronik zu
geben. Die bendtigte Entwicklungssoftware ist frei iiber die Webseiten des Elektronik Studiengangs
der Fachhochschule Technikum Wien verfiigbar bzw. dort verlinkt. Der eStick selbst kann {iber die

folgende Adresse gegen einen geringen Unkostenbeitrag erworben werden:

Fachhochschule Technikum Wien

Sekretariat Studiengang Elektronik, 5. Stock

Hochstidtplatz 5

A-1200 Wien

WEB: http://www.technikum-wien.at/bel

FAX: +43 1333 40 77 268
Fiir die Entwicklung eigener Anwendungen fiir und mit dem eStick stehen verschiedene Varianten
zur Verfiigung. ,,Low-Level*“ Programmierung in Assembler oder mit mit einer Programmiersprache
einer hoheren Abstraktion wie C. Assembly Programme resultieren zumeist in effizienteren
Applikationen und vermeiden Probleme und Fehler die durch Verwendung eines doch eher
komplexeren Compilers — insbesondere im Kontext von Embedded Systems — ungewollt passieren
konnen. Andererseits erlaubt die Verwendung einer Hochsprache effizienteres Programmieren und
ein leichteres retargeting einer Applikation auf einen anderen Mikrocontroller.
In beiden Fillen erfolgt die Programmeingabe in der Regel mittels Texteditor. Das Programm selbst
wird dann mittels Compiler, Assembler, Linker und Locator in ein ausfiihrbares Programm-Image
iibersetzt. Bei Embedded Systems (Mikrocontroller basierten) Anwendungen ist dies meist eine
Textdatei im Intel-HEX Format. Das entwickelte Programm kann nun entweder mit Hilfe eines
Simulators rein in Software oder mit Hilfe eines Debuggers auf der Hardware evaluiert werden, ob
dies den prinzipiellen Anforderungen geniigt. Letzten Endes wird das Programm-Image mit Hilfe
eines Flashtools resident auf die Hardware geladen, von wo aus diese dann automatisch nach einem
Reset exekutiert werden kann.
Das vorliegende ,,Getting Started zeigt die Programmentwicklung in der Programmiersprache C

mit Hilfe des freien GNU C-Compilers WinAVR.



Vor der Installation muss das Programmpaket aus dem Internet geladen werden:

e WinAVR: http://winavr.sourceforge.net » Download (23 MB)

Nach dem Download starten Sie das Installationsprogramm und folgen Sie einfach den Anleitungen

des Installationswizards. Im folgenden Beispiel wurde das Verzeichnis c:\estick\winavr gewéhlt.

WinAVR 20080610 Installation

EEx

Willkommen beim Installations-
Assistenten fir WinAVR 20080610

Dieser Assistent wird Sie durch die Installation von WinAvR
20080610 begleiten,

Es wird empfohlen wvor der Installation alle anderen
Programme zu schlieffen, damit bestimmte Systemdateien
ohne Meustart ersetzt werden kinnen,

Klicken Sie auf \Weiter, um Forkzufahren.

WinAVR 20080610 Installation

Lizenzabkommen
Bitte lesen Sie die Lizenzbedingungen durch, bevor Sie mit der Installation FortFabren, @

Driicken Sie die Bild-nach-unten Taste, um den Rest des Abkommens zu sehen.

W\nAVR Licensing Information -

GMU Binutils is distributed under the GMU GPL License.

GNU Compiler Collection {GCC) is distributed under the GHU GPL License.

avt-libe is distributed under a BSD License.

avrdude is distributed under the GMU GPL License.

avrdude-gui is distributed under the GMU GFL License,

GMU Debugger (GDE) is distributed under the GNU GPL License.

Insight is distributed under the GNU GPL License

SirnulayR. is distribubed under the GNU GPL License ~

Falls Sie alle Bedingungen des Abkommens akzeptieran, kicken Sie auf Annehmen, Sie missen
die Lizenzvereinbarungen anerkennen, um WindWR 20080610 installieren zu kinnen,

< Zuriick “ Annehmen PL [ Abbrechen ]

WinAVR 20080610 Installation

[l

Wahlen Sie das Yerzeichnis aus, in das \WinAYR 20020610 instaliert werden soll, @

Zielverzeichnis auswahlen

WindVR 20080610 wird in das unten angegebene Yerzeichnis installiert, Falls Sie in ein
anderes Yerzeichnis installieren machten, Kicken Sie auf Durchsuchen und wahlen Sie ein
anderes Yerzeichnis aus, Klicken Sie auf Weiter, um Fortzufahren.

Zielverzeichnis

CHeStckiWinayR|

Bendtigter Speicher: 127, 0ME
‘erfiigharer Speicher: 4.8GE

l < Zuriick “ Wieiter '\L [ Abbrechen ]
12

& WinAYR 20080610 Installation

ok

‘Wwahlen Sie die Komponenten aus, die Sie installieren machken. @

Komponenten auswihlen

‘Wahlen Sie die Komponenten aus, die Sie installieren méchken und wahlen Sie disjenigen ab,
die Sie nicht instalieren wollen, Klicken Sie auf Instalieren, um die Installation zu starten,

‘Wahlen Sie die Komponenten stall Files

?nlé?h?;-se instalieren Add Directories to PATH (Recommended)
' Install Programmers Mokepad

Bendtigter Speicher: 127, 0MB

[ < Zuriick. ” Installieren %[ Abbrechen

Abbildung 1: WinAVR Installation - Screenshots
Anmerkung: Mit WinAVR konnen bereits C-Programme in Intel-Hex Programm Images iibersetzt

werden. Einzig ein Simulator fiir den AT9OUSB162 Mikrocontroller, der auf dem eStick zum Einsatz

kommt, fehlt hier.

Starten Sie den Texteditor ,,Programmers Notepad* {iber das Startmenii.
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Abbildung 2: Programmers-Notepad
Wie bei den meisten Entwicklungsumgebungen {iblich besteht die Default-Ansicht aus mehreren
Bereichen. Im Bereich Projekt-Verwaltung wird das Projekt verwaltet indem Code Dateien zu
einem Projekt hinzugefiigt und davon auch wieder entfernt werden koénnen. Im Text-Editor Bereich
wird editiert und im Bereich Output werden Status und Fehler Meldungen des Compilers beim

Ubersetzen des Quellcodes ausgegeben.

Anlegen eines neuen Projektes und hinzufiigen von Code:
Zum Anlegen eines leeren Projekts wihlen Sie iiber das Menii File » Project » New Project. Im
erscheinenden Dialog vergeben Sie einen Namen fiir das Projekt sowie ein Verzeichnis wo dieses

angelegt werden soll, z.B. Projektname: blinky, Projektverzeichnis c:\eStick\data\blinky.

New Project... rz|

[‘:’}[

Empty Project

Name: ‘ biinky| |

Folder: ‘C:\est\ck\data\bhnky vl [B

Abbildung 3: New-Project Wizard Dialog
Im Text-Editor Bereich geben Sie folgenden C-Code (siehe Listing 1 — jedoch ohne die
Zeilennummern und Doppelpunkte) ein. Danach speichern Sie die Datei (File » Save As ...) im

zuvor gewihlten Arbeitsverzeichnis unter dem Namen blinky.c ab.



Fiigen Sie nun die erstellte C Source Datei zu dem Projekt hinzu; klicken Sie dazu im
Projektbereich auf den Namen des Projekts blinky — klick auf die rechte Maustaste » Add Files und

wéhlen Sie im folgenden Dialog die zuvor gesicherte Datei blinky.c aus.

€ Programmer's Notepad - [blinky.c]
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Abbildung 4: Hinzufiigen/Entfernen von Quelldateien zu einem Projekt

0l: |#include <avr/io.h>

02: |#include <util/delay.h>

03:

04: |/* C- Macro Definitions */

05: #define SET_LED(x) PORTB=PORTB& (~ (1<<x))

06: #define CLEAR LED(x) PORTB=PORTB| (1<<x)

07:

08: |int main (void)

09: {

10: DDRB = OxFF; /* set the Port PORTB to output */
11: PORTB = OxFF; /* write all 1s to PORTB */
12: DDRC = 0x04; /* set the Port Pin PORTC.2 to output */
13: PORTC = 0x04; /* set the Port Pin PORTC.2 (LE) */
14: while (1) /* endless loop */
15: {

16: SET_LED(0) ; /* turn LED 0 on */
17: _delay ms(50); /* wait 500 ms */
18: CLEAR LED(O); /* turn LED 0 off */
19: _delay ms(50); /* wait 500 ms */
20: }

21: }

Listing 1: blinky.c

Erlduterungen zum Source Code Listing 1 finden Sie im Anschluss an diesen Abschnitt.

Um das Programm zu compilieren ist ein so genanntes Make file hilfreich. Kopieren Sie dazu aus



dem Ordner WinAVR\sample die Datei Makefile in Ihr jeweiliges Arbeitsverzeichnis, z.B.
c:\estick\data\blinky. Offnen Sie diese Datei im Programmers Notepad und #ndern Sie die Zeilen
beginnend mit MCU, F CPU und TARGET auf folgende Werte:

MCU = at90usblé62

F CPU = 8000000

TARGET = blinky

£ Programmer’s Notepad - [Makefile]

' File Edt view Tools ‘“Window Help - |8 =
DA EHB| = 5 Make v it [EE v g Fnd -
;‘ I Makefile [ :‘ I
() Mew Project Group + bug reports to the GEC project. A
=) biinky *
& r_'lk:hnky.: ﬁTD rebuild project do "make clean” then "make all".

# MCU name
MCU = ato0ushlez

# Processor fraeguancy.
F_CPU = BOOOOOO

# output format. {can be srec, ihex, binary)
FORMAT = ihex

# Target file name (without extension).| T
TARGET = bTlinky

# ohject files directory

#+ To put ohject files in current directory, use a dot C.),
# this an empty or blank macro!

OBIDIR = .

I <
&l Propects | [@)a 0 + 9
r X

Data: 0 bytes (0.0% Full)
(.data + .bss + .noinit)

> Process Exit Code: O
> me Taken: 00:02

< >
[55:40] : 601 ANST LF M5 | Ready

Abbildung 5: Editieren des Makefile und compilieren des Projekts

Nun kann das Projekt iiber das Menii Tools » [WinAVR] Make All compiliert werden. Treten Fehler
auf so werden diese im Output-Bereich aufgelistet (der erste Fehler verweist zumeist auf die Stelle
wo dieser das erste mal offenkundig wurde — d.h. der Fehler befindet sich entweder in der
angegebenen Zeile oder davor), andernfalls erhalten Sie hier eine Erfolgsmeldung dhnlich der
Abbildung 5. Im Arbeitsverzeichnis liegt nun eine Datei blinky.hex vor, die mit einem Flashtool,
z.B. dem eStickFashTool auf den eStick resident programmiert werden kann.

Starten Sie dazu das Flashtool, verbinden Sie den eStick bei gedriickt gehaltener Taste mit einem
freien USB Port, laden/6ffnen Sie die Datei blinky.hex, fiilhren Sie die Programmierung durch
(ERASE, PROGRAM, VERIFY) und starten Sie die Applikation. Danach sollte eine Leuchtdiode

am eStick langsam blinken.

Erliuterungen zum Source Code in Listing 1:

In den Zeilen 01 und 02 werden vordefinierte Bibliotheken {iber die Preprozessoranweisung

#include eingebunden. Diese befinden sich im Unterverzeichnis ,,avr wo WinAVR installiert



wurde. Die Datei 10 .h bindet Registerdefinitionen ein, sodass diese mit demselben Namen, wie im
Datenblatt des Mikrocontroller angegeben, verwendet werden konnen. Erst durch das Einbinden
dieser Datei kann im Folgenden auf Register wie DDRR oder PORTB zugegriffen bzw. geschrieben
werden. Die Datei delay.h definiert diverse Wartefunktionen wie bspw. delay ms (), die die
Programmausfiihrung um eine angegebene Anzahl an ms verzogert.

In den Zeilen 08 bis 21 ist die main () Funktion realisiert. Jedes C Programm bendtigt eine
main () Funktion — hier beginnt und endet zumeist die Anwendung. Die Zeilen 10-13 umfassen
den Initialisierungsteil, der einmal am beginn der Exekution der Anwendung durchlaufen wird. In
den Zeilen 14-20 wird eine Endlosschleife realisiert; jedes Mikrocontroller Programm weist im
Hauptteil typischerweise eine Endlosschleife auf, da Embedded Systems Applikationen in der Regel
nicht enden.

Im Initialisierungsteil in Zeile 10 wird der PORTB des Mikrocontrollers, an dem die Leuchtdioden
iiber einen D-Latch Baustein angeschlossen sind, zunédchst auf Ausgang geschaltet (DDRx steht fiir
Data Direction Register). Danach wird in Zeile 11 auf allen acht PORTB Leitungen eine 1
ausgegeben (OxFF ist die hexadezimale Zahlendarstellung fiir das bindre Bitmuster 1111 1111). Die
Leuchtdioden sind low aktiv, und leuchten wenn diese mit einer 0 angesteuert werden; d.h. initial
sind somit alle Leuchtdioden dunkel.

In Zeile 12 wird das dritte Bit von PORTC (d.h. PORTC (2) ) auf Ausgang konfiguriert. Danach
wird in Zeile 13 der Pin Latch Enable des Latch Bausteins auf 1 gesetzt indem an PORTC ein
Bitmuster ausgegeben wird, dass an der dritten Position eine 1 aufweist (0x04 hexadezimal
entspricht bindr 0000 0100). Wann immer das Latch Enable eines Latch Bausteins 1 ist, ist dieses
transparent, d.h. die Eingiinge werden an die Ausginge durchgeschaltet. Ist der Latch Enable Pin
jedoch 0 so bleibt der letzte Zustand der Ausgénge erhalten.

In Zeile 16 wird der Pin POTRB (0) iiber ein Makro, welches in Zeile 05 deklariert wurde, auf 0
gesetzt. Dadurch wird die dort — {iber den nun transparent konfigurierten Latch Baustein —
angeschlossene Leuchtdiode eingeschaltet. Danach wird die weitere Programmausfiihrung iiber die
Wartefunktion delay ms (50) verzogert. Nach dem verstreichen dieser Zeit wird PORTB (0)
in Zeile 18 tber das in Zeile 06 deklarierte CLEAR PORT (x) Makro wieder auf 1 gesetzt; die
Leuchtdiode erlischt. Im Anschluss wird in Zeile 19 abermals gewartet bevor die Endlosschleife

erneut bei Zeile 16 erneut von vorne beginnt.

e http://www.mikrocontroller.net/articles/AVR-Tutorial

e http://www.mikrocontroller.net/articles/ AVR-GCC-Tutorial



Fiir das Programmieren miissen oft Bits an bestimmten Positionen auf 0 oder 1 gesetzt werden.
Dazu ist es meist einfacher die Zahlen Hexadezimal anzuschreiben. Mit der bindren Schreibweise
ist es zwar schneller offenkundig welche Bitposition beeinflusst werden soll, die langen
Kombinationen an Oen und len sind jedoch sehr rasch fehleranfdllig. Daher fast man iiblicherweise
vier Bits (ein Nibble) zusammen und rechnet mit unten stehender Tabelle die Bindrzahl ins
Hexadezimale Pendant um. Dass eine Zahl im hexadezimalen Format angeschrieben wird, wird
zumeist durch ein vorangestelltes 0x gekennzeichnet.

Beispiel: Das Bitmuster Ob 1011 entspricht der hexadezimalen Zahl 0xB.

Dezimal Hexadezimal Binar
0 0x00 0b 0000 0000
1 0x01 0b 0000 0001
2 0x02 0b 0000 0010
3 0x03 0b 0000 0011
4 0x04 0b 0000 0100
5 0x05 0b 0000 0101
6 0x06 0b 0000 0110
7 0x07 Ob 0000 0111
8 0x08 0b 0000 1000
9 0x09 0b 0000 1001
10 0x0A 0b 0000 1010
11 0x0B 0b 0000 1011
12 0x0C 0b 0000 1100
13 0x0D 0b 0000 1101
14 0x0E Ob 0000 1110
15 0xOF 0b 0000 1111
100 0x64 0b 01100100
255 0xFF Ob 1111 1111

Tabelle 1: Dezimal-, Hexadezimal- und Bindrdarstellung
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